BSBITU311 - Use Simple Relational Databases

CHAPTER 1 GETT|NG TO KNOW ACCESS 201 6

( : INFOcus

Microsoft Access 2016 is described as a database management
system (DBMS).

A database is a structure that contains data. You enter data into the
database via a variety of sources including typing (data entry),
importing from other sources, and even electronically and
automatically from other equipment (data logging). The data can
then be manipulated by the DBMS to provide a range of useful
information.

In this session you will:

v'gain an understanding of how Access works and what it
can be used for

v'learn how to start Access from the desktop

v'gain an understanding of the Access Start screen

v learn how to create a new blank database

v/ gain an understanding of the Backstage View

v'learn how to open an existing database file

v/ gain an understanding of the Access screen

v" learn how to work with the Navigation pane to filter
database objects

v learn how to work with Touch Mode

v"learn how to work with a table

v"learn how to work with other database objects

v"learn how to close a database file

v'learn how to exit from Access.
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UNDERSTANDING MICROSOFT ACCESS 2016

Microsoft Access has a reputation for being a and a good orientation to Microsoft Access will
more difficult application to learn and use than greatly help in understanding how this powerful
other Office applications such as Word, Excel application can be used to perform a range of
and PowerPoint. There are many reasons for this useful jobs.

How Access Is Different

Unlike other Office 2016 applications such as, Word, Excel and PowerPoint where you can start to
create something useful almost immediately and directly on the screen, with Access you must first
design and create structures to hold your data, and then create special template layouts for displaying,
manipulating and presenting that data in a useful and meaningful way. In other words, rather than just
creating something through trial and error, Access requires more thought, more planning and good
designs in order to be used effectively. While there is a lot of ‘learn by doing’ involved with Access,
there is also great deal to learn before you start using it.

How Access Works
Basically, Access allows you to do two main things:
¢ it allows you to store huge amounts of data

¢ it allows you to manipulate that data to produce relevant and useful information. This is what
Database Management Systems (DBMS) are all about, and the good news is that Access is
one of the easiest of these to learn and use.

Data is stored in tables. Tables are structures made up of rows and columns and are similar in
appearance and operation to Excel worksheets. You need to design and create these tables yourself
before the data can be entered.

The data in tables is manipulated using forms, reports and queries. A form is mostly used for data
entry (although you can enter data directly into a table). A report is used to manipulate the data and
present it either on the screen or printed on paper in a more pleasing way. A query is used to produce
a subset of the data — for example, in a sales system you may only want to see the sales in the
northwest region.

Forms, reports and queries are created as layout frameworks. Once the framework has been
designed you can then run the data from the tables through them. Indeed, this is a common theme
throughout Microsoft Access: design versus display. You create or modify a form, report or query in
desigh mode, and then preview the data in display mode.

Even tables (that store your data) conform to this design/display metaphor. You design a table
structure, then enter the data in a display (they call it a datasheet) view.

Tables, forms, reports and queries are known as database objects. In fact, each of these is like a
mini-application within the broader Access application. Each has a very large range of commands and
options that you can use to both design the structure or framework, and also use to display data.

What Can Access Be Used For?

You can use Access to create a system for managing your music or stamp collection, membership at
your local soccer or polo club, petty cash, inventory and stock control, or sales at work and much,
much more. Any situation where you need to store data, manipulate it, and then present it as useful
information is a perfect contender for Access.

The only disadvantage with Access is that unless you use one of the pre-created system templates,

you need to plan and design the system and the database objects (the tables, forms, reports and
queries) used in that system. This is what takes time and learning to do.
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STARTING ACCESS FROM THE DESKTOP

To create a new database or work with an web and Windows bar or the All apps list in the
existing one, the first thing you must do is to start Start menu. You can choose to pin it to the Start
Microsoft Access. The first time you use Access menu or the taskbar so that you can access it more
you need to open it from the taskbar Search the quickly and easily the next time you use it.
Try This Yourself: 0 lifeata glance
Before you begin, ensure
that your computer is W3 Word 2013
switched on and the desktop Besr Ui > Calendar
is displayed...
/= Adobe Acrobat DC
o If there is no Access icon in } memet Exploer () e O
the taskbar at the bottom of : :
the desktop, click on the Notepad B
Windows icon in the ) Maps Sloudy
taskbar, as shown, to display 15° 195 02 m;

the Start menu
Melbourne Phone Compa...  Onelote

Click on All apps to display
a list of all the apps on your

Play and explore

computer
Scroll down to the A section S — o) O]
Access 2016 is listed here... 5 Settings Xbox EwEE EE
Click on Access 2016 to - SBP/ASK ALL...

o 5,288.60
start Access . ¥ -041%

. ] All apps 4:11 PM AEDT
Right-click on the Access

icon in the taskbar to display Y kearch the web and Windows
a menu of options, as shown,
then select Pin this
program to taskbar

You can now click on this
icon to open Access from the
desktop. This icon will Close window
remain in the taskbar unless
you remove it...

g Access 2016

<= Pin this program to taskbar

Repeat step 5 to select
Close window to close
Access

Click on the Access icon in
the taskbar to open Access
again

For Your Reference... Handy to Know...
To pin Access to the taskbar: e You can start Access by clicking in the
1. From the Start screen, click on the down taskbar Search... bar, typing access, then
arrow icon to d|sp|ay the Apps screen CIICkIng on Access in the list of search
2. Locate and right-click on Access 2016 results.
3. Click on Pin to taskbar e You can pin Access to the Start menu by

displaying the All apps list, right-clicking on
Access 2016 and selecting Pin to Start.
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UNDERSTANDING THE START SCREEN

Most times you open Access, a start screen will recently accessed files, open a database which has
display. From this initial screen, you can choose been saved to Computer or OneDrive or create a
what kind of database you want to work with. You new database using the available templates.

can choose to work with one of your most

Microsoft Access 2016 Start Screen

The Microsoft Access 2016 start screen is very helpful if you want to quickly access a database you
have worked on recently or create a new database based on one of the available templates (including
the default Blank desktop database).

If you have already worked on a database or several databases in Access, a list of recent databases will
display below Recent in the pane to the left of the screen. If you haven’t worked on any databases yet,
you can still open existing databases by clicking on the link, Open Other Files, located below Recent.
This lets you open an existing file from your computer or OneDrive.

The main pane of the start screen displays available templates you can use to create a new database
and a search box you can use to search the internet for additional templates. Templates are simply
layouts that have already been created which you can customise to suit your needs and then enter
relevant content. If you want to start with a clean slate you can choose the Blank desktop database
template — you’ll probably find this is the one you will use the most. Templates displaying the globe icon
(e.g. Asset tracking) use the web-based SharePoint servers to host your database and make it
available over the internet (note that these templates require subscriptions).

In the top right corner of the screen you'll see information about the account you've used to sign into
Windows as well as help, minimise, restore down, and close tools.

B = [m] x
Search for online templates 2 Cara Hemphl"
Ccess N 2 4 CaraH@watpub2.local
Suggested searches: Database Business Logs Industry Lists Switch account
Personal  Inventories
Recent
You haven't opened any files recently. To browse for a file, start by clicking on
Open Other Files.
[@¥ Open Other Files |_]

Blank database Custom web app Updated: Asset tracking

S lmp e

Updated: Contacts Updated: Students Updated: Event management

The start screen will only display when you launch the Access 2016 application directly — that is, by
clicking on Access 2016 from the Windows 10 Start menu or clicking on the taskbar icon if the
application has been pinned to the taskbar.

Access 2016 can also be started in Windows 10 by double-clicking on an Access database in File
Explorer. When this occurs Access 2016 will start with the database open on the screen and the start
screen shown above will be bypassed.
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CREATING A NEW BLANK DATABASE

When you launch Microsoft Access 2016, you will available templates. Most of the templates shown
be presented with the start screen, which are web-based and may involve a subscription to
enables you to open an existing database or Office 365. You can also simply create a new,
create a new one based on one of a multitude of blank desktop database which is free.
[ 1] :
Try This Yourself: Blank database
. . Should | create an Access app
Before starting this HEN File Narme
exercise you MUST Database1
ensure that the ACCESS C:h\Users\CaraH\Documents,
2016 Start screen is
displayed...
o In the right pane, click \j
on Blank desktop Create
[~
database
You will be asked to
name the database... e N ”
] Blank database
e Type My Databas? n Should | create an Access app or an Access desktop database?
File Name, then click on — N | FileName
the Browse icon to My Database.accdb
dlsplay the Flle NeW C:\Course File for Microsoft Access 2016\
Database dialog box, |
locate and double-click
on C:/Course Files for \j
BSB — Office 2016 and L
click on [OK] Create
You could click on the
Next arrow to display
the other built-in s My Database : Database- C:\Course File .. Cara Hemphill 2 - O
templates and use one i Home Create External Data Database Tools Fields Q Tell me what you want to do
of those m_stead, but we M o 12 BB ! o 2
will stay with the blank Ve, | Shon Db Comency fe Mody =
template... - Te Bu~ &8 Mermo Settings % | validation «
Views Add & Delete - Properties Formatting ~
e Click on [Create] to All Access Obje... @ « || = Tablet : *
ID ~ | Click to Add -~
open the new blank Se”; £l (New)
database in Access B raorer
Access has created a
single blank table for
you to begin with
For Your Reference... Handy to Know...
To create a new blank database: o |If you already have a database open and
1. In the start screen, click on Blank desktop want to create a new one, click on the File
database tab to open the Backstage, then click on

2. Type a File Name, click on [Browse] and New and click on Blank desktop database.

select a save in location
3. Click on [OK] then click on [Create]
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Before you can properly enter Microsoft Access
2016, you must have a database file open. A
database file is where your database objects
(tables, forms, reports, queries etc) for a

BSBITU311 - Use Simple Relational Databases

UNDERSTANDING THE BACKSTAGE VIEW

particular system or project you are working on are
located. The Backstage view is accessed using
the File tab and provides you with file information
and enables you to print, save and more.

The Backstage

The File tab on the ribbon is not a
standard tab. Clicking on the File
tab launches a mini-program within
Microsoft Access called Backstage
view, also called simply
Backstage.

A navigation pane occupies the left
side of the Backstage. The options
in this pane enable you to access a
number of operations, such as
printing and saving and can also
provide you with information about
your database such as size.

Click on the options in the
navigation pane to change the
display in the pane on the right.

My Database : Database- C:\Course File for Microsoft Access 2016\M...

Info

My Database

C: » Course File for Microsoft Access 2016

¥ Compact & Repair
H Help prevent and carrect database file
Compact & prablems by using Compact and Repair.
Repair Database

= Encrypt with Password
Use a password to restrict access to your
Encrypt with database. Files that use the 2007
Account Password J Microsoft Access file format or later are
encrypted.

Options

Feedback

View and edit database properties

The Backstage Options

Info

New

Open

Save

Save As

Print
Close
Account

Options

Feedback

Provides status information about the current database and lets
you compact and repair the database and encrypt it with a
password.

Enables you to create a new database and provides access to
inbuilt templates as well as ready access to a range of online
templates.

Provides a list of recent documents as well as the option to
search through your Computer, SkyDrive or other place, to find
what you are looking for.

Saves your current object (table, query, form etc).

Enables you to save the current database in a different format
(e.g. as .mdb, compatible with versions earlier than 2007) and/or
in a different location.

Enables you to print the current object and preview it.
Closes your current database.
Contains product and user information.

Displays the Access Options dialog box, which presents you
with options for setting up how Access works in general and
options (preferences) for the current database.

Allows you to provide Feedback to Microsoft on any issues or
suggestions you have about Access.

Account

Options

Feedback
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OPENING AN EXISTING DATABASE FILE

A good way to see how Access 2016 works is to been opened, it may appear in the Recent

open an existing database file. To open a Database list. However, if it doesn’t appear there,
database file, you need to use the Open option in you will need to use one of the other Open options
the Backstage. If the database file has recently to search for and open it.

A Sample Database : Database- C:\Courseware Content\Microsoft Ac... i 1 4 - (m] x

Try This Yourself:
Before starting this exercise Open
ensure that Access has

L C: > Courseware Content > Micro...
Recent
started... ®

o Click on the File tab to open @ OneDrive @ ASample Databas..  1/08/2016 250 PM
the Backstage, then click on
Open to display the Open

options

TJ Thisec
=
o= AddaPlace

Browse:

Let’s change the folder
location to display our existing
database files... Cptions

Click on This PC under Open

Account

Feedback

in the middle pane 9

This will display the current
folder and any recent folders. £ open x
Let’S assume these are not the &« v 4 « Local Disk (C3) > Course File for Microsoft Access 2016 w| @ | Search Course File for Micros... @

folders that we need... Organise = New folder . m @

[ Documents A Name Date modified Type

Click on Browse to display the 3 Dovnloads
Open dialog box b Music

= Pictures

Double-click on the icon for C: B Videos
drive, then double-click on the = =N _
DVD RW Drive (E:) MYOB Education E

Course Files for BSB - = Publications (\WATPUB-NAS) (X:)
Office 2016 folder =% Production (WWATPUB-NAS) (¥:)

= Support (WWATPUB-NAS) (Z:)

Click on A Sample & Newwork
Database.accdb, then click on ole >
[Open] to open the database p o] [ Microsott Access v

If a security warning displays T —

7] A Sample Database
A1603 Create Database_1
A1603 Create Database_2
5 A1603 Create Database_3
©| A1603 Create Database_4
My Database

© 6 00

in the yellow info bar just e
below the ribbon, click on

[Enable Content] to close the
info bar

For Your Reference... Handy to Know...
To open an existing database file: e You can use the keyboard shortcut c] +[© ]
1. Select Open in Backstage view at any time to display the Open area in
2. Move to the folder that contains the file Backstage view.
3. Click on the file to select it
4. Click on [Open]
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UNDERSTANDING THE ACCESS 2016 SCREEN

At first glance there’s not much to an Access (tables, forms, reports, queries, etc). It isn’t until
2016 database screen. The screen really only you choose to perform one of these operations that
gives you access to either create, modify, or run the screen really becomes more intricate.

one of the database objects in a database file

A Sample Database : Database- C:\Courseware Content\Microsoft...

Create External Data Database Tools Q@ Tell me what you want to do

Ascending

View Paste Filter Descending Refresh Find
Remove Sort All
Views | Clipboard = Sort E:LFiIter Records Find Text Formatting ~
All Access Obje... ® «
Searchi, yol
Tables 2
j Asset ltems
Quenes F3

e 'ﬁj qryComputerHardwareinOw...

'ﬁj qryCostsSummedByCwner

'ﬁj qryG5TCalculations

»

Forms

EI frmassetinventory

% frmAssetitemsDataForm
% frmG5TCalculations
o ———Repers— 2
E rptassetlistinglnMumberCrder
Eﬂ rptAssetsGroupedByOwners
Bl rptGsTPaidByMonth

(5 |

Ready Mum Lock

o The ribbon is the tabbed band that appears across the top of the window. It is the command control
centre of Access 2016. You use the tabs on the ribbon to access commands which have been
categorised into groups. Commands can be buttons or sometimes include galleries of formatting
options that you can select from. This area really comes to life when a database object is opened.

The File tab of the ribbon is used to access file management functions such as saving, opening, closing,
printing, etc. Access Options are also available so that you can set your working preferences and options
for Access 2016.

The main part of the screen is the data area. Here a database object will appear either in design or in
preview mode. The database object must first be opened before it will appear so, even though Asset
Items in the screen above is selected, it hasn’t yet been opened.

The Navigation pane is used to list and navigate the various database objects (tables, forms, reports,
queries, etc) that exist in the database. By default, all objects are displayed (as shown above) but it is
possible to filter the pane to show, for instance, only objects of one type (e.g. tables).

The Security and Message area displays information about the database object that is currently open.
Since there are no objects open the area is not showing much at the moment other than the fact that it is
ready for you to begin.
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WORKING WITH THE NAVIGATION PANE

The Navigation pane is an essential part of more or less objects and you should get a pretty
Access 2016 as it provides you with access to good grasp on how it operates before you begin to
the database objects that are in your database create tables and other database objects.

file. The pane itself can be filtered to show you

0 All Access Obje...%‘?" « a Queries ® «

Search. e

Try This Yourself:
Navigate To Category

Continue using the 'ﬁj qryComputerHardwarelnOw...

() Custom
E previous ﬂle With thiS Obiect Tvpe 'flj gryCostssummedByOwner
g exercise, or open the file =R R : T ayesTCalauistions
8 A Samp|e Tables and Related Views .
Database.accdb... Created Date

. Modified Date
Click on the All Access

Objects drop arrow in the

Filter By Group

Navigation pane, as Tables |
shown Queries |
A menu will display... Eorms

. Reports .
Select Queries under - _ |
Filter By Group to see All Access Objects i
onIy the saved query = | rptAssets GroupedByOwners
objects in the database fl rptesTPaidByMonth

Click on the drop arrow

again and select Reports
to see only the reports e

All Access Obje... @ « O Al Access Obje... @ «

A - Search.

Click on the drop arrow - L are L
again and select All TabRg & Tables &
Access ObjECtS to see 'j Asset [tems 'j Asset [tems
all of the database objects Queries & Queries ®
Click on the'arrow to the 'flj gryComputerHardwarelnOw... 'flj gryComputerHardwarelinCw...
right of Forms in the 'ﬁj gryCostsSummedByOwner 'ﬁj qryCostsSummedByOwner
Navigation pane EF qryGSTCaleulations BF aryGsTCalculations

. . Forms ¥ Forms %
The forms will be hidden R . _
and the arrows will eports E ES] frmassetinventory
Change to double down i@ rotAssetlistinginNumberOrder =E] frmAssetitemsDataFarm
arrows... @ rptassetsGroupedByOwners =2| frmGSTCalculations

Eﬂ rptG5TRaidByMonth Reports 3

0 Click on the arrow to the
right of Forms to display
the forms again @ rptassetsGroupedByOwners

f@ rptesTPaidByMonth

Eﬂ rptAssetlistinglnMumberOrder

For Your Reference... Handy to Know...
To filter database objects in the Navigation e The Navigation pane menu is quite
pane: complex. Once you’'ve become proficient with
1. Click on the All Access Objects drop arrow it you can list the objects by date created or
for the object type in the Navigation pane modified. However, the best option is to list

2. Select the desired filter option objects grouped according to their type.
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WORKING WITH TOUCH MODE

These days many people are using Office
programs on touchscreen devices such as tablets
and even smart phones. Because these screens
are small, it is easy to accidentally tap the

incorrect command. To help prevent this, you can
activate touch mode which creates more space
between tools on the QAT, commands on the
ribbon, and the tabs on the ribbon.

Table Toaols
Try This Yourself: — _
Home | Customize Quick Access Toolbar ase Tools Fields Table
. . . . Mew
c , Before starting this exercise (Y4 o 9 V- [§ eter X
o9 3 o pen T 28c
8‘ [ you MUST Open the flle A View Paste EEI v Save ?g 2 Refresh ol Save &
Sample Database.accdb... . _ sort All- X Delete - [
Views Clip Email r Records
0 Click on Customise Quick All Access ( QuickPrint
Access TOOIbar’ as shown Search.. it Preaes Com’:lsust'::iztrzs\foa?e - GEQ Rorilse
Spelling
Tables Computer Hardware GEO Blast
e Select Touch/Mouse Mode BT assetitems | ¥ Undo Office Furniture FurnTown
g g - Office Furniture FurnTown
This will only add the tool to the ‘;e"es_c 7 E:dT Computer Hardwars | GEO Biast
uick Access toolbar, not qrylomputer ode Computer Hardware GED Blast
Sctivate TOUCh mode i’T—‘ qryCostssumn Refresh All Office Furniture FurnTown
o ‘}T—‘ qGSTCalcula 5 Al Office Furniture FurnTown
q yne s Office Furniture Granville
e F:|ICk on Touch/Mouse Mode Forms Touch/Mouse Mode Computer Software WicroSwitt
in the QAT to open a menu Bl frmassetinven More Commands.. General Equipment Brenda
B frmAssetitems Office Furniture FurnTown
Mouse mode is selected by _ Show Below the Ribbon Computer Hardware GEQ Rocke
( B frmosTCaleulamons [ (30067 Computer Hardware GEOQ Rocke

default. With this mode the
commands are optimised for
use with a mouse...

Select Touch

The tools on the Quick Access
toolbar, tabs on the ribbon and
each command on the ribbon
will spread out significantly.
Let’s revert to the default
Mouse mode...

Repeat steps 3 and 4, selecting
Mouse to activate Mouse
mode

Let’s remove the tool from the
Quick Access toolbar...

Right-click on Touch/Mouse
Mode in the QAT and select
Remove from Quick Access
Toolbar

skv =  ASample Database: Database- C:\... Table Tools
Home Optimize spacing between commands Fields Table
. Mouse
= = N

bA/ :”-_%: Standard ribbon and commands. ’7 = E

) Bz Optimized for use with mouse. - & Save =
View Paste | b Refresh

- . Touch All - )( Delete ~ D'
Views Clig :| ’_—_| |: More space between commands. Records

Optimized for use with touch.

All Access Cuyen —

[ AssetMo - Asset Category - Ma

Despite its name, Touch mode can be used with a mouse and
may suit people who have difficulty with fine mouse movements.

a A A Sample Database : Databa... Table Tools

Create External Data Database Tools Fields Table

. A -

M R

= [ -
B Z Yo H ABC
B fitee Al 13 E= v

View Paste Refresh

> All~ x > Dv

Views Clipboard ] Sort & Filter Records

For Your Reference...
To activate Touch mode:

1. Click on Customise Quick Access Toolbar

2. Select Touch/Mouse Mode

3. Click on Touch/Mouse Mode in the Quick

Access toolbar
4. Select Touch

Handy to Know...

e When you activate Touch mode in one
Office application, it is automatically
activated in all other Office programs (Word,
Outlook, etc.) immediately.
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WORKING WITH A TABLE

A table is used in a database file to store data. A
table has a defined structure and in Access 2016
whenever the table is open, it is seen either in
Desigh mode or in Datasheet mode. When it is

BSBITU311 - Use Simple Relational Databases

in Design mode you can make changes to the
structure of the table but not to the data itself, and
when it is in Datasheet mode you can make
changes to the data but not to the structure.

A Sample Database : Database- C:\Course... Table Tools
Try Thls Yourse”' Create External Data Database Tools Fields Table Q Tell me wh
Continue using the N | g cu Y 2l Ascending - &) =nNe >3 jo, %
Q . . - n = O z T o 3] e
previous file with this Vo | Pae DB | g, ADmendng Bl e v
) eXerCise, or Open the f||e - - Format Painter Remove Sort All~ )( Delete - D' [§
% A Sample Views Clipboard ] Sort BL.FiIter Records Find
(7] H &) « =_=j Asset ltems
Database.accdb... All Access Ob-Je ) AssetNo - Asset Category - Make -
search. Pl T30050 Computer Hardware GEO Rocket
o Ensure Datasheet Tables 2 || 30051 Computer Hardware GEO Blast
mode is active ~ if no, = G
in the Navigation pane, Quenies _ | 30054 Computer Hardware | GEO Blast
double-click on Asset B _ayComputerHardwareinOw... 30055 Computer Hardware GEO Blast
i:]e?rigggz:gagéis - = A Sample Database : Database- C:\Course...  Tab
| Vi
access to the actual Home Create External Data Database Tools
data === €= |nsert Rows = =
E . = e
H D ? ™ r-l_ﬁl/ X Delete Rows - F [
e On the Home tab, CI|Ck View | Primary Builder Test Validation = dify Look Property Indexes Create Data Rename/ Re|
. o ! Modify Lookups -
on the '[Op half of View . Key Rules EE P Sheet . .Macros Delete Macro
. . Views Tools i Show/Hide Field, Record & Table Events
in the Views group to All Access Obip.. ® «|| 2 Asetiems\
switch to Design view )€ = LT T —
This mode displays the lim:m £ Short Text Recq
= - Asset Category Short Text Recq
structure of the table. T Assetitems Make Short Text Recd
There are also view ‘%‘““C oo | odel Short Text Recc
= gryComputerHardwarelinOw... escription ort Tex ecq
buttons at the bottom of °
the screen which allow e s
you to toggle between
Design and Datasheet
modes... A field name can be up to 64 characters long,
. including spaces, Press F1 for help on field
o Click on Datasheet Yes names.
. . y No
View in .the bottom right Ver o Duplicates
of the window, as Ves
shown, to see the data o ontrel
again General
. S| Bt
o Click on Close ‘Asset Rl =
Items’ in the top right o x
corner of the main pane Model . Descriplion - - Twnar k.
. 05€ ASSEL ltems
as shown (just beneath p20X Eompuley 53 1
. Surger 350 Computer Sales
the rlbbon) to C|OS€ the GasRiser Computer Chair Sales
table WideSpan Credenza Sales
Surger 350 XL | Computer Admin & Accounts

For Your Reference...

Handy to Know...

To display a table: e Clicking on View in the Views group (on the
1. In the Navigation pane, double-click on the Home tab) toggles between Design and
table name to display the table in datasheet Datasheet views for an open table. For
view example, if you are in Datasheet view,
2. On the Home tab, click on View in the Views glrlliikizgeo\?e\r/sl,gw il Enteln e DESTim M
group to toggle the view to Design mode ’
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WORKING WITH OTHER DATABASE OBJECTS

The key thing to remember with database objects
including tables is that, when open, they will
either be in Design mode where you can make
changes to the structure or layout of the object,

or in Data mode where data is parsed through the
object’s layout and presented to you. Once the
object is open, it is easy to toggle between these
two modes of operation.

Try This Yourself:

Create

A Sample Database : Database- C:\Course File for Microsoft Access 2016\A Sample Databas

External Data Database Tools Q Tell me what you want to do

q n ] CL A - - e a
»  Continue using the b o Y iimendmg e 2 O
— g o : g ] i e 5 3> -
T  previous file with this View | Paste =P | ey AvDeCending Wl S Find
) eXerCise, or Open the f|le - Format Painter Remove Sort All~ Delete I:l - [} -
% A Sam Ie Views Clipboard ] - Sort & Filter Records Find
@ Databapse accdb All Access Obje... @ « || E ssset tem: | & aryCostsSummedByOwner \
. B Owner . Asset Category .| SumOfCost -
Search. P nts Computer Hardware $16,332.00
o In the NaViga‘[ion pane, Tables # || | Admin & Accounts General Equipment $3,744.00
P H B Asset ltems ____ Admin & Accounts Office Furniture $1,212.00
double-click on Queries 4 ||....|Maintenance Computer Hardware $6,974.50
qryCostSSummed ByOw - ) ) || Maintenance Computer Software $899.00
ner under Queries to run B anComputerHardwareinOw... ___ Maintenance General Equipment $4,656.00
. i’T—‘ qryCostsSummedByCwner _|Maintenance Office Furniture $3,504.00
the query and d|5p|ay the ‘}T—‘ i . Management Office Furniture $3,425.50
qryGSTCalculations = -
Production Comnuter Hardware 29 784 /0

data parsed through it

On the Home tab, click on
the top half of View in the
Views group to display
the design of the query

Hame

Create

A Sample Database : Database- C\Course...  Query Tools

QT

External Data Database Tools ell me what you want to

Click on Close to close D I D’j |:| +I #1Update (D Union L €= Insert Rows U Insert
the query - : - * [ Crosstab &3 Pass-Through Delete Rows % Delete
View  Run Select Make Append Show
o Double-click on - Table ! Delete  E£ Data Definition Table < Builder T@ Return
rptAssetsGroupedByOw Results S Queype : uenpetip
o H &) « =_=j Asset ltems =_5,-.| gryCostsSummedByOwner
ners under Reports to All Access Obje... & | 5 ssettems |
run the report and display Search.. L Asset Items
it in preview mode hies & - =
B Asset ltems % Asset No
o Click on Design View in Queries A Asset Cat
the task bar at the bottom B anComputerHardwarelnOw.. Make [~
right of the window to 2 anCostssummedsyOwner .
display the design B anGsTCallations Field: | GHVERR | Asset Category Cost

structure of the report

Click on Close to close
the report

For Your Reference...

Handy to Know...

To work with other database objects: e For forms and reports there is a Layout
1. Inthe Navigation pane, double-click on the view. In Design view you see the name of
object name to run the object the controls used to display the data. You
2. On the Home tab, click on View to see the don’.t actqally see where the data ends up in
' design of the obje'ct Design view. In Layout view you see the
data but can still make changes to the actual
layout of the form or report.
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